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IMA Marine Data Hub (MDH) Training Outline 

Day 1 

Module 1: Introduction to EGIS and GeoPortals 

Lecture: 

• Review of GIS Concepts 

• Traditional vs Web-Based GIS 

• GIS Web Service Fundamentals 

• Esri’s ArcGIS Enterprise Platform 

• MDH Architecture and Components 

• Overview of the Marine Data Hub 

Practical: 

• Exploring the Marine Data Hub 

• Accessing the MDH EGIS Portal 

• ArcGIS Portal User Types 

• Overview of ArcGIS Pro 3.0 

 

Module 2: Geospatial Data Acquisition and Management 

Lecture: 

• Geospatial Data for Information Products 

• Data Acquisition Techniques 

• Field Data Collection using Smart Mobile Devices  

• Geospatial Data Storage and Management 

• User Managed vs ArcGIS Managed Data 

• The ArcGIS DataStore 

• Metadata 

• Datums and Map Projections 

Practical: 

• Creating and Configuring Enterprise Workgroup Databases in ArcMap 

• Connecting to Workgroup Databases in ArcGIS Pro 

• Creating and Managing Database Users 

• Configuring Permissions 

• Loading and Manipulating Geospatial Data 

• Creating Geospatial Data Using ArcGIS Pro 
 

Day 2: 

Module 3: Geospatial Content Creation and Dissemination 

Lecture: 

• Creating and Managing Geospatial Content in MDH 

• The Role of the Map Viewer for Content Creation 

• Managing Content Using Groups and Tags 

• Creating/Uploading Content to EGIS Portal 

• Publishing Content from ArcGIS Pro 

• Connecting to a Portal from ArcGIS Pro  

• Disseminating Content Using Web Apps 
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Practical: 

• Creating/Uploading Geospatial Content 

• Searching and Accessing Content 

• Exploring the MDH Data Categories 

• Working with Groups and Tags 

• Linking Content to MDH Data Categories using Tags 

• Preparing and Sharing Content from ArcGIS Pro as a Web Service 

• Accessing Portal Content in ArcGIS Pro 

• Creating Web Maps using MDH GeoPortal Content 

• Developing Web Applications using the Web App Builder 

 

Module 4: Marine Data Hub Administration 

Lecture: 

• Review of the MDH Architecture 

• Fundamentals of GeoPortal Administration 

• Managing User Access with Groups 

• Data Backup and Protection 

• ArcGIS Server Manager 

• ArcGIS Server Manager and Portal for ArcGIS Admin Pages 

• Log Files 

• ArcGIS Monitor – Brief Introduction 

Practical: 

• Overview of the MDH GeoPortal Organization Page 

• Creating and Managing Users 

• Creating New User Roles 

• Automating Administrative tasks Using ArcGIS Notebooks 

• Backing up and Restoring Geospatial Data 

• Troubleshooting and Using ArcGIS Server Manager Log Files 
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Introduction 

This training course introduces GIS concepts and tools used to efficiently store, edit, manage and share 

data on IMA’s Enterprise GIS and Marine Biodiversity Hub. You will acquire and master fundamental 

skills that will prepare you to perform common GIS workflows in your organisation such as creating 

geodatabases, creating web maps and apps and collaborating via the Marine Diversity Hub GeoPortal. 

The training material covers both theory and practical exercises. 

 

REQUIRED BACKGROUND 

This course is designed for individuals who have no or minimal experience with GIS. An open, alert 

mind is all that is required. 

 

REQUIRED MATERIALS 

To successfully complete this course, you will need:  

• A web browser, ArcMap 10.8.x and ArcGIS Pro 2.x/3.0  

• Lecture Notes: provided by course facilitator 

• Training Manual: provided by course facilitator 

• Sample data: provided by course facilitator 
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Module 1: Introduction to E-GIS and GeoHubs 

The Marine Data Hub (MDH) is a geospatial information portal focused on marine data for Trinidad 

and Tobago. The portal can be found here: https://mdh.ima.gov.tt/portal/apps/sites/#/datahub. It 

fosters and encourages the creation and sharing of marine data for improved analysis and decision-

making through the Enterprise GIS (EGIS). The EGIS can be found here: 

https://mdh.ima.gov.tt/portal/home/index.html. This module will provide an overview of the portal’s 

interface and capabilities.  

 

Module objectives 

At the end of this practical you should be: 

1) Familiar with the Marine Data Hub interface 

2) Able to locate data in the Hub 

3) Access the E-GIS 

4) Familiar with the E-GIS interface 

 

1.1 Exploring the Marine Data Hub 

The Marine Data Hub is a website interface powered by ArcGIS Hub to facilitate geospatial content 

access and management in the E-GIS. In this section, you will be introduced to the Portal. 

 

 

On the Data Hub you can access data that has been made public. The main header of the Hub allows 

the users to navigate to the E-GIS Portal (requires login), the Trinidad and Tobago Biodiversity Hub, 

Training Resources, and the IMA’s website. 

 

https://mdh.ima.gov.tt/portal/apps/sites/#/datahub
https://mdh.ima.gov.tt/portal/home/index.html
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Below the header, there is a description of the MDH. At the top-right of the homepage, the user can 

sign-in using provided E-GIS Portal credentials. It is not required to sign-in to the E-GIS to view and 

use public resources, however, tags and groups allow discoverability of the resources of the Hub to 

be managed and restricted as necessary. 

Scrolling down on the homepage provides the user quick links to various categories of data.  

 

 

1.1.1 Filtering and searching for content 

Accessing geospatial data resources on Hub can be done by searching the Data Catalog. 

 STEPS: 

1. Click a Data Category, the loads all available content in that category on the Catalog page. 

2. You can filter the content using the Data, Documents and Apps and Maps tabs at the top of 

the list.  

3. You can also search for content using the search bar at the top of the page.  

 

1.1.2 Using content 

Once you have located a suitable data item, you can review the item, download it and even create 

maps or visualisations.  

STEPS: 

1. Click the title of the item.  

2. This takes you to a summary page which displays metadata for the item. 
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3. Depending on the permissions set, you can edit, filter and download this data 

using the icons that appear to the right of the summary.  

4. At the bottom of the summary tab, click I want to use this to review the options 

for using the data item. Options include creating a map and creating a story map. 

 

 

 

1.2 Explore the MDH Enterprise GIS Portal 

The MDH E-GIS Portal is a core component of the GIS platform as it integrates all desktop, server, 

mobile and web elements of the E-GIS. The E-GIS Portal allows organisations to share and access data 

across the organisation via the E-GIS Portal website. This data is stored securely on your organisation’s 

servers, allowing for a high degree of collaboration while maintain security. 

The E-GIS Portal can be found using the link above or in the top menu of the Hub page. You can create 

geospatial products and data such as maps, apps and surveys. 

STEPS: 

1. Navigate to the Hub using the link above.  

2. The EGIS interface has seven tabs (two visible only when logged in) at the top left and a sign-

in option at the top right. 

 

3. Sign-in using the credentials provided to you.  

4. At the top are links to the major sections of the portal: Gallery, Map, Scene and Groups.  

a. Gallery: shows selected maps and applications that can be accessed by everyone.  

b. Map: create a web map  
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c. Scene: create 3D views 

d. Groups: Used to share and edit content with selected persons. View groups that you 

have created or been added to. 

e. Content: View layers, maps and applications you have created.  

f. Organization: Provides site information on members and data (visible to 

administrators). 

5. Click Map tab at the top of the window to open 

the map viewer. A new map called My Map 

opens. 

6. By default, a topographic map of the world is 

displayed, centred on Trinidad and Tobago. You 

can change this by clicking Basemap at the top. 

Basemaps provide context to users of your map. 

There are 23 options; change the default 

basemap to Imagery.  

7. Click Add to review the options. You can add 

layers in 5 ways: 

• Search for Layers: This option searches for layers within an organisation’s content 

based on entered search parameters or searches all content on ArcGIS Online. 

• Add Layer from File: Use this option to import a shapefile, delimited text file or GPX 

file.  

• Add Layer from Web: With this option you can use online data in the form of an 

ArcGIS Web Service, KML or CSV by entering the URL. 

• Add Map Note: With this option you can create annotate features on your map. 

• Browse Living Atlas Layers: Searches all Living Atlas content on ArcGIS Online. 

 

1.3 Reviewing Portal User Types, Roles and Privileges 

The E-GIS uses a combination of user types and roles to control the privileges assigned to members.  

All users are assigned a role when added to the E-GIS. There are two user types available in your 

oragnisation: Creator and Viewer.  

 

1.3.1 Creator and Viewer User Types 

Members assigned as Creators can create edit and create 2D data, 3D content, maps, apps and 

perform geospatial analysis. This user type can also function as administrator in the E-GIS (if assigned 

this role) allowing them to activate user accounts in the E-GIS and administer the Portal site. 
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This user type also has access to all the essential apps such as ArcGIS Map Viewer, Dashboards, 

StoryMaps, Web AppBuilder and Experience Builder. All field apps are also available (Field Maps, 

Survey 123 and QuickCapture). 

Members assigned as Viewers are often persons who need to view and use maps and applications, for 

example, operations dashboards, but are not responsible for creating them. Viewers can access 

content from all the essential apps previously mentioned. They can view content using field apps.  

 

1.3.2 Roles 

A role defines the privileges that a user type has. There are five default roles in your organisation: 

Administrator, Publisher, User, Data Editor and Viewer.  

Viewer: view items such as maps, apps, scenes, and layers that have been shared with the public, the 

organization, or a group to which the member belongs. Cannot share or create content. The role can 

be assigned to all user types. 

Data Editor: Viewer privileges plus the ability to edit features shared by other users. The Data Editor 

role can be assigned to all user types except Viewer. 

User: Data Editor privileges plus the ability to create groups and content. Users can use the 

organization's maps, apps, layers, and tools, and join groups that allow members to update all items 

in the group. Members assigned the User role can also create maps and apps, edit features, add items 

to the portal, share content, and create groups. The User role is compatible with the Creator user type. 

Publisher: User privileges plus the ability to publish hosted web layers, ArcGIS Server layers, register 

data stores, publish from data store items and perform analysis. The Publisher role is compatible with 

the Creator user type. 

Administrator: Publisher privileges plus privileges to manage the organization and other users. An 

organization must have at least one administrator, two is recommended, however. For security 

reasons, you should only assign this role to those who require the additional privileges associated with 

it. The Administrator role is compatible with the Creator user type. 

 

1.4  Overview of ArcGIS Pro 3.0 

ArcGIS Pro is a desktop application that facilitates a seamless experience between the desktop and 
web geospatial content. ArcGIS Pro allows you to work in data in both 2D and 3D. You can also have 
multiple maps, layouts, tables and charts within a single project.  
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Setting up a new project 
a. Open the ArcGIS Pro application and sign-in with your EGIS Online account.  
b. Create a new project using the Map template. By default, ArcGIS Pro documents are 

organised into projects. This makes maps and their associated layers more portable. Note, to 
ensure maximum portability you should import any required layers into the project database 
or make a copy to the project folder.  

c. Name the project then click Ok.  

 
d. ArcGIS Pro’s interface has four main sections:  

a. The menus and ribbon 
b. The Contents pane which acts as a table of content for the layers in your map 
c. The Map View which displays the contents of the layers added 
d. The Catalog pane which allows easy access to local and web-based layers 

 
 
ArcGIS Pro is a ribbon-based application, like many other Windows applications. The main parts of the 

ArcGIS Pro interface are the ribbon, views, and panes. In ArcGIS Pro, a body of related work—

consisting of maps, scenes, layouts, data, tables, tools, and connections to other resources—is 

typically organized in a project. By default, a project is stored in its own system folder. Project files 

have the extension .aprx. A project also has its own geodatabase (a file with the extension .gdb) and 

its own toolbox (a file with the extension .tbx).  

 
Ribbons 

Many commands are available from the ribbon at the top of the ArcGIS Pro window. ArcGIS Pro uses 

a horizontal ribbon at the top of the application window to display and organize functionality into a 

series of tabs. Some of these tabs (core tabs) are always present. Others (contextual tabs) appear 

when the application is in a particular state. Above the map view is the ribbon. The ribbon has a set of 

core tabs—Map, Insert, Analysis, View, Edit, Imagery, and Share—that are always present when a 

map view is active. Each tab has its own set of tools, organized in groups. 

 

Map tab 

 

a) The Map tab is where you will find tools used to interact with Maps in your project. 

b) You can have multiple maps in a single project. 
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Insert tab 

 

a) The Insert tab allows you to create new maps and layouts in your project as well as import 

existing maps into your project. 

b) The Import Map tool can be used to import existing ArcGIS ArcMap documents into your 

project. 

 

Analysis tab 

 

a) The Analysis tab is where you will perform geoprocessing tasks using tools similar to ArcGIS 

Desktop. 

b) Depending on the content in you ArcGIS Pro Projects, different geoprocessing tools will be 

exposed and active. 

 

View tab 

 

a) The View tab controls how you view the content of your project. This includes viewing the 

Contents panel. 

 

Edit tab 

 

a) The Edit tab is where all of the feature editing tools and tasks are found. Unlike ArcMap, 

Editing is always enabled in ArcGIS Pro, you do not need to start or stop editing to perform 

editing operations. 

b) Edit tools are context sensitive and active depending on the type of active feature selected in 

the project. 
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Imagery tab 

 

a) The Imagery tab controls imagery and raster functions. 

 

Share tab 

 

a) The share tab is used to share your ArcGIS Pro projects with other users or to ArcGIS Online 

or Portal. In ArcGIS Pro, you can package your project including data into a project package 

that can be shared online or with other users who have the appropriate file system access. 

 

Views 

Views are windows for working with maps, scenes, tables, layouts, charts, reports, and other 

presentations of data. A project may have many views, which can be opened and closed as needed. 

Several views can be open at the same time, but only one is active.  
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1: A map view is a window that displays a map.  

2: Every view has a tab that can be used to close the view or drag it to a different position. The tab of 

the active view is blue. Clicking a view tab makes the view active.  

 

Panes  

A pane is a dockable window that displays the contents of a view (the Contents pane), the contents of 

a project or portal (the Catalog pane), or commands and settings related to an area of functionality, 

such as the Symbology and Geoprocessing panes.  
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Locating the E-GIS web layers 
a. Go to the Catalog pane at the right. If it is not visible, go to View > Catalog pane. 
b. Click Portal then the Groups icon (second from left). Open data layers on the portal are 

shared to various groups. If you know which group the layer you require is shared to you can 
double-click the group to open it and add a layer to your map. Alternatively, you can enter 
search terms in the search field. 

                                                                    
 
Adding web-based feature layers to the map 

a. In the Catalog pane, go to Portal > Groups. Find the group of interest, open it and add the 
required layer to the map.  

b. The layers should appear at the left in the Contents pane. 
 
Symbolising layers in ArcGIS Pro 

c. Vector layers are symbolised randomly as they are added to a map. You can configure the 
colour, pattern, transparency and more in the layer’s properties. 

d. Double-click the symbol below the protected area layer in the Contents pane.  
e. The Symbology pane will open at the right.  
f. You can select a preconfigured symbol in the gallery or create a custom symbol by going to 

Properties. 
g. Change the protected areas symbol to a red outline 2pts wide. Click Apply when complete. 

 
Adding local data to a map  

h. First, confirm the location of your local data in the file explorer. If needed, copy your data to 
the required location. 

i. In the Catalog pane at the right, click Project. From here you can navigate and add data, 
maps and databases from your local machine or network. The pane organises content by 
type. All maps create in the project appear in the Maps node.  Local folders containing data 
layers can be accessed from the Folders node. 

 
j. To add folder connection or shortcut to the project, open Folders using the small triangle at 

the left of the icon. You should see the default folder identified by a small house icon. Right-
click the Folders node then click Add Folder Connection. 
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k. In the Add Folder Connection window that appears, navigate to your folder location then 

click once to select it. Click Ok to complete the process. 
l. The shortcut should appear in Folders. 
m. Expand the folder. Your data layers should appear. 
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Module 2: Geospatial Data Acquisition and Management 

The geodatabase is the primary data storage mechanism in ArcGIS. For small and medium 

organisations collaboration across units is expected. Field teams often collect data that needs to be 

used, edited and analysed by other teams.  

ArcSDE (Arc Spatial Data Engine) geodatabases allow you to use other ESRI products, as well as custom 

applications to store, use and manage all your GIS data in one of the following commercial database 

management systems: Oracle, Microsoft SQL Server, IBM DB2, IBM Informix, or PostgreSQL. ArcSDE is 

sometimes described as middleware, software that sits between Esri’s ArcGIS products and RDBMS 

software and manages data exchanges between them. 

Multiuser geodatabases require the use of ArcSDE and can be unlimited in size and numbers of users. 

There are 3 types/levels of ArcSDE geodatabases — Desktop (Personal SDE), Workgroup and 

Enterprise. While Enterprise geodatabases allow the most flexibility, all levels of ArcSDE allow you to 

store your data in a central database and support the concurrent multiuser editing necessary for most 

GIS data management workflows and are scalable from one to the other.  

In the ArcGIS platform, the term database server refers to instances of Microsoft SQL Server Express 

that have been enabled to store geodatabases. You create geodatabases and perform other 

administrative tasks for database servers through the Database Servers node in the Catalog window 

or ArcCatalog in ArcMap.  

 

 
Desktop/Personal SDE 
Geodatabases 

Workgroup SDE 
Geodatabases 

Enterprise SDE 
Geodatabases 

Application Scenario Small teams/single user Small or medium department Large scale enterprise 

Data Storage SQL Server Express SQL Server Express Enterprise RDBMS 
-Oracle 
-SQL Server 
-PostgreSQL 

Management Interface ArcCatalog ArcCatalog ArcCatalog 
RDBMS 
ArcSDE command line 

Storage Capacity 10 GB 10 GB Depends on DBMS limits 

Licensing ArcGIS Desktop Advanced 
ArcGIS Desktop Standard 

ArcGIS for Server 
Workgroup 

ArcGIS for Server Enterprise 

Platform Windows Windows Any 

Number of concurrent users 1 editor and 3 readers 10 editors and readers Unlimited editors and readers 
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2.1 Creating and Configuring Enterprise Workgroup Databases in ArcMap 

Before you can create a Workgroup geodatabase, you must connect to an ArcSDE database server. 

Creating geodatabases requires server administrator permissions on the database server. Follow the 

steps below to create a new geodatabase: 

STEPS:  

1. Open ArcMap. 

2. Locate the Catalog pane and expand the Database Servers folder in the catalog tree.  

3. In the Database Server box, enter: <Your Computer Name>\<Instance name>. Click 

Ok when complete.  

4. The database server should appear in the catalog tree. Right-click the new server connection 

to confirm you are connected – it should be greyed out.  

5. Select Permissions. The user account that was used to create the database server should be 

checked as the Server administrator.  

 

6. In the Catalog tree, right-click the database server and click New Geodatabase.  

7. Enter Training as the geodatabase name then click OK.  

8. The new geodatabase is added under the connected database server. 
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2.2 Connecting to a Workgroup Geodatabase in ArcMap 

To access data in a multiuser geodatabase, clients must connect to the geodatabase. The connection 

is made directly using an ArcSDE service. 

STEPS: 

1. Expand the Database Connections folder in the Catalog tree. 

2. Double-click Add Database Connection. This opens the Database Connection dialog box. 

3. SQL Server is automatically entered in the Database Platform field. 

4. In the Instance text box, type the name of the server on which the SQL Express database 

resides. Type <Computer Name>\<Instance name>. 

5. Leave Authentication Type as default. 

6. In the Database field, type Training.  

7. Click OK. 

8. If successful, the connection is created. Rename the connection Training@<Computer 

Name> by right-click the connection and selecting Rename. 

9. Double-click the connection to connect to the Training geodatabase. 

 

2.3 Connecting to a Workgroup Geodatabase in ArcGIS Pro 

To access data in a multiuser geodatabase, clients must connect to the geodatabase. The connection 

is made directly using an ArcSDE service. 

STEPS: 

1. Open your previous ArcGIS Pro project.  

2. In the Insert menu, click Connections.  

3. Select Database > New Database Connection. This opens the Database Connection window. 

 

4. Change the Database Platform to SQL Server.   

5. In ArcMap right-click the database server and select Properties. Copy the Name and paste this 

in the Instance field in ArcGIS Pro. 
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6. Leave Authentication Type as Operating system authentication. 

7. Click the Database field. Once your instance name is correctly entered, ArcGIS will connect to 

the database server and display a list of all geodatabases on the database server. Select the 

Training database then click Ok.  

 

8. In the Catalog pane, expand the Databases section. The database connection should be 

visible.  

9. By default the connection is named using the computer name. Right-click the connection and 

rename it Training@<Computer name>. 

 

 

2.4 Creating and Managing Database Users 

Database administrators add logins to the SQL Server instance and these logins are mapped to users 

in individual databases on the SQL Server instance. The Create Database User tool can be used to add 

users to add users to a server instance or database. You can add users that have an existing Windows 

user account or create a database user that does not have a Windows user account.  

SQL Server database access is grant using logins. A login allows SQL Server to know who is connecting 

to the server. Access to a geodatabase(s) is granted through users. While logins deal with 

authentication, user accounts provide authorisation to perform tasks in a geodatabase. 

STEPS: 

1. In Windows Settings, go to the Accounts the click Add account.  

2. Click I don’t have this person’s sign-in information.  

3. Click Add a user without a Microsoft account.  

4. Create two accounts: ResearchOfficer and FieldOfficer. 

5. Right-click the connection and go to Administration > Create Database User. 
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6. Check the Create Operating System 

Authenticated User box.  

7. Enter the user account name with the following 

format: <Domain/computer 

name>\ResearchOfficer 

8. Click Run.  

9. Switch to ArcMap.  

10. Right-click the database server and select 

Permissions. The Permissions window should 

open displaying all users added to the database server. The database user created should be 

visible in the list. 

 

11. You can also add or remove users using the Permissions window in ArcMap. Try adding the 

FieldOfficer user account. 

12. Note: when adding users from ArcMap: you can add either domain or local Windows logins or 

groups. That means the logins and groups must exist on the network or the local computer 

before you can add them to the database server. 

 

2.5 Configuring Permissions 

Once a geodatabase is created many persons in an organisation may need to use it. Since their job 

and responsibilities differ, the level of access each person has will also vary. Generally, there are three 

categories of users roles: server administrators, geodatabase administrators and geodatabase users. 

The server administrator performs the administrative tasks for the database server and the 

geodatabases on it. Geodatabase administrators perform a similar function but only for geodatabases 

they are assigned to administrate.  

Users added to the database server must be granted permission to each geodatabase on the server. 

Only the server administrator has automatic access to all geodatabases on the server. Permissions can 

be configured to at the database server level, the geodatabase level and the dataset level. 

 

 

https://enterprise.arcgis.com/en/documentation/install/database-server/10.8/add-users-database-servers.htm
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STEPS: 

1. Right-click the Training geodatabase and select Permissions.  

2. Select the server administrator. Notice that you cannot configure permissions for the server 

administrator.  

3. Click the ResearchOfficer user that was added. By default, the user has no permissions. Radio 

buttons at the bottom of the window indicate the permissions currently granted to each user 

for the selected geodatabase. 

4. Make the ResearchOfficer a Geodatabase Administrator by selecting that option in the 

Permissions window. Assign the FieldOfficer Read/Write permissions. 

5. Click Apply then OK.  

 

 

2.6 Loading and Manipulating Geospatial Data 

Loading data into a Workgroup database can be done using the menu options available by right 

clicking the geodatabase connection.  

STEPS: 

1. In ArcGIS Pro, right-click the Training database 

connection. 

2. Select Import > Feature classes. 

3. In the Feature Class to Geodatabase window, navigate 

to your data using the Browse icon select the 

watershed and rivers shapefiles for Trinidad and 

Tobago. 

4. Click Run. 

5. Right-click the database connection then click Refresh. 

The feature classes should be now visible.  

6. With data loaded, you can perform standard tasks such as renaming, copying and deleting. 

7. As the server or geodatabase administrator, you can further control the access through the 

Privileges options.  

8. Right click the Trinidad Rivers feature class and select Privileges. 

9. Give the FieldOfficer Select privileges only. 

10. Login to the FieldOfficer account to and test the permissions. 
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2.7 Creating Geospatial Data using ArcGIS Pro 

There are several ways to create ways. Heads-up digitizing is the most commonplace digitising 

method. With head-up digitising, you display an aerial photograph, satellite image or ortho-

photograph onscreen as a basemap, then you draw features such as roads, buildings or parcels on top 

of it. 

ArcGIS Pro automatically starts an edit session when you modify existing data or create new data. You 

can edit any data source that is granted view and edit privileges. Saving or discarding your edits 

automatically stops the edit session. Any subsequent edits you make resumes the edit session until 

you save or discard your edits. By default, there are no buttons to start or stop an edit session. 

STEPS: 

1. Locate the Databases node in the Catalog pane. By default, all projects have a geodatabase 
to store related project files. Importing all related files makes your project more portable if it 
needs to be shared with colleagues. 

2. Right-click the Training geodatabase then click New > Feature Class. The New Feature Class 
dialog box should open. 

3. In the Name field, enter Mangroves.  
4. The Type should be set to Point.  

 

5. Click Next. 
6. In the first field enter Name under Field Name and set the Data Type to Text. Set the length 

to 40. 
7. Click Finish to accept all other defaults and create the feature class. It should appear in your 

table of contents.  
8. In the Map menu, click Basemap and select Imagery. 

9. Click on the Create  tool in the Edit tab.  
10. This should open the Create Features pane at the right-

hand side of your screen, displaying all the current editable 
layers.  

11. Click on the Create Feature icon for the Mangrove layer. 
This reveals all the point editing tools available. 

12. When the Create Feature icon is active the mouse cursor 
changes shape over the map and any click on the map will add a vertex.  

13. Zoom in to a mangrove. 
14. Click once to create a point. Locate and create additional points.  

15. Select one of the points you digitised using the Select Features tool . 

16. Click the Attributes button . The Attributes pane will open at the left.  
17. Click the Name field to enter the name of the mangrove.  
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Module 3: Geospatial Content Creation and Dissemination 

Creating and organisation of spatial data are two of the most common activities you will do in ArcGIS 

Pro. This requires knowledge of how to edit and import data in ArcGIS Pro. Where datasets already 

exists, digitizing is the process of converting features into a digital format. Alternatively, you can need 

to upload data directly to the portal. 

This module will guide you through essential editing and data management processes in ArcGIS Pro. 

 

3.1 Uploading Geospatial Content 

If you have existing Shapefiles, CSVs or Excel files with spatial data, you can upload them to ArcGIS 

Online. A shapefile is an Esri vector data storage format for storing the location, shape, and attributes 

of geographic features. It is stored as a set of related files and contains one feature class. The primary 

way to upload a shapefile is to add it to a .zip file, upload it. You should zip the shapefile directly, that 

is, do not place the files in a folder before zipping. Instead, select all the associated files, then right-

click then select Compress to ZIP file. 

STEPS: 

1. In ArcGIS Online, click Content. This takes you to your content page. 

2. In the top left corner, click New Item . The New item pane should open, 

displaying the various options available to upload files or create layers directly online. 

 

3. Drag your files onto the pane to upload the file.  

4. The location fields are also automatically detected. Click Next. 

5. The new layer will be created in your personal content page but you can organise your content 

using folders. 

6. Add tags as appropriate. 

7. Enter a summary then click Save. 

8. Once the layer is created, the Overview page of the layer should open.  

9. From the Overview page you can: 

o Data: review the data in the layer 

o Visualisation: preview the location of the features 

o Usage: see how many times the layer has been used or viewed 

o Settings: allows you to turn on delete protection, mark a layer as authoritative (useful 

if the data is from official sources), turn on editing which allows users to make changes 

to the features or add new features and allow users to export the data 
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3.2 Searching and Accessing Content 

To access the MDH EGIS Portal, either directly or by choosing EGIS from the Hub page or following this 

link. Data uploaded or published to the portal should be organised into folders, groups and 

appropriately tagged. 

STEPS: 

1. Login to the EGIS.  

2. Click Content at the top of the page.  

3. By default, you are taken to your personal My Content page. Any items you create is listed 

here. Under My Favorites, any item you have starred will appear. Data assigned to any groups 

you create or are a member of will be listed under My Groups and all content you have access 

to within the organisation (portal) with be under My Organisation. Under each tab there is a 

search bar that allows you to search for content.  

 

4. At the left of the window, you can create folders using the Create new folder icon . To 

move items to a folder, select the required items then click Move and select the 

require folder. 

 

3.3 Exploring the MDH Data Categories 

Content in the MDH is organised into 6 categories: Biodiversity & Ecology, Marine Chemistry, Fisheries 

& Aquaculture, Oceanic & Coastal Processes, GIS and Marine Governance & Policy. 

STEPS: 

1. Open the Marine Data Hub. Scroll to the bottom of the page click a data category.  

2. Any data linked to the category is listed. This included maps, apps and feature layers.  

3. Click an item to see the full metadata.  

4. Depending on the item, users can download, view, filter or open it. Users can also create maps 

or create a storymap. 

 

3.4 Working with Groups and Tags 

Groups allow you to manage the access and visibility of layers, surveys, maps and applications. It 

facilitates collaborative work with smaller groups on the platform. Before creating a group, carefully 

consider the data products to be created and the level of access needed by members of your 

department. When creating items, you must apply tags. This aids in searching content. If necessary, 

organisations may choose to standardise the tags being used to ensure consistency. 

STEPS: 

1. Click Groups at the top of the page.  

2. At the top left, click Create Group. 

3. Fill in the Group’s name, summary and tags.  

https://mdh.ima.gov.tt/portal/home/index.html
https://mdh.ima.gov.tt/portal/home/index.html
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4. Group configuration options: 

a) How can people join the group?  
I. By invitation: Use if the group’s content members should be strictly 

managed 
II. By request: Use to allow portal members optional membership 

III. By adding themselves: Use to allow portal members self-managed 
membership 

b) Who can view this group?  
I. Only Group Members: Use if the group should only be visible to your 

department 
II. All organisation members: Use if everyone with login access to the EGIS 

should see the group 
III. Everyone (public): Use if the group should be visible to the public 

(without login) 
NB: If the Everyone option is used, you can configure so that anyone 

can join the group, members must be invited or only those who request 

to join and are approved are member of the group.  

c) Who can contribute content to the group?  
I. Group members: Use if only group members can share content to the 

group 
II. Only group owner and managers: Use if the group owner and managers 

will be responsible for sharing content. This option may be useful for 
managing ‘viewers’.  

d) Who can see the list of members on the Members tab? 
I. All group members: Use if members can see each other 

II. Only group owner and managers: Use if limiting the member list view 
 

Group designations can also be configured. Shared update allows members to update items 

in the group. If it a group in which members cannot leave, use the Administrative group option. 

 

5. Click Save when complete.  

6. Use Invite Users add users to the group and Add items to group to add content.  

 

3.5 Linking Content to MDH Data Categories using Tags 

The MDH content is sourced from the EGIS. For items to available in the MDH publicly, the item must 

be shared with the public, assigned to the Marine Data Hub Content group and be tagged to appear 

in the appropriate data category. Tags for each category are: 
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Data Category Tags 

Biodiversity & Ecology 
biodiversity, ecology, 
wetlands 

Marine Chemistry marine 

Fisheries & Aquaculture fish 

Oceanic & Coastal Processes  

GIS fundamental data 

Marine Governance & Policy transportation 

 

STEPS: 

1. Tags are assigned when data is created but they also can be updated from the Item Detail 

page. 

2. In Content, click the ellipsis button  then click View Item Details. 

3. From the Item Details page you can update metadata, group sharing, tags, attribution, add 

terms of use and change the owner of the item (by the portal administrator). 

4. Scroll down the page to the Tags section. Click Edit to add or update a tag.  

 

3.6 Preparing and Sharing Content from ArcGIS Pro as a Web Service 

There are seven web layer types that can be shared from ArcGIS Pro: feature, tile, vector tile, map 

image, imagery, scene, and elevation. Feature, tile, vector tile, map image, and imagery layers share 

2D data, while scene and elevation layers share 3D data. You can publish maps with multiple layers 

and tables as a web layer or service. layers in your map become service sublayers. Each sublayer is 

identified by a unique numeric ID that allows you to work with it or reference it in a web map or 

application. 

STEPS: 
1. In ArcGIS Pro, prepare a map with content to be published to the Portal. 

2. In the Table of contents, right-click the map  and select Properties. Check the Allow 
assignment of unique numeric IDs for sharing web layers box. Click Ok when complete. 

3. In the menu click Share > Web Layer. The Share Map As Web Layer panel will open at the 
right.  

4. Fill in the Name, Summary and Tags. Separate each tag with a comma.  
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5. In the Layer Type section, check Feature. 
6. For Location, click the dropdown to select and existing folder or create a new one. The layer 

will be saved to the selected folder in Contents on the portal. 
7. In Share with, you can choose to share the layer to the public or a group.  
8. Click Configuration. In this tab you can configure the capabilities of the layer and select the 

appropriate time zone if needed. Click the Edit button . Here you can enable editing and 
select what users can edit. You can also allow the layer to be downloaded using the Export 
Data option. If the layer will be used in a mobile application, use the Enable Sync option. 

9. Click Configure Parameters . If the layer has date fields, select the local time zone.  
10. Click Analyze. This checks the map for any errors.  
11. Click Publish. The process will take a few minutes. Layers with more features will take longer 

to publish. 
12. Once complete you will see a message in the tab. 

 
13. In the web browser, go to your Content page and confirm that the layer has been published. 

If needed, refresh the page. 
 
 

3.7 Accessing Portal Content in ArcGIS Pro 

You can add content to an ArcGIS Pro project from your portal. You can browse, search, filter, and sort 

portal content and add it to maps and scenes just as you do with content stored locally or in other 

locations. Portal content includes items owned by you and items owned by others that are made 

available to you through sharing. 

STEPS: 

1. In the Catalog pane, click Portal.  

2. The top row allows you to see data items from My Content , My Favorites , My Groups 

, My Organisation , ArcGIS Enterprise  and the Living Atlas .  

3. You can sort and filter the data and switch between content and groups on the My Groups, 

My Organisation and ArcGIS Enterprise tabs.  

4. Once you have located and item of interest, right click and select Add to Current Map or Add 

to New.  
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3.8 Creating Web Maps using MDH GeoPortal Content 

Web maps typically have two types of layers: operational layers which display the main themes of 

your map and a base layer which provides context to the operational layers.  

STEPS: 

1. Go to Map page in the Geoportal. At the top of the page click Open new map in Map Viewer. 

N.B. Performing analysis functions can only be done in Map Viewer Classic currently. This 

functionally should be migrated to Map Viewer within the coming months. Maps can be 

created and used in either view. 

2. By default, a topographic map of the world is displayed, this provides geographic context such 

as water bodies and political boundaries. 

 

3. The Map Viewer includes two vertical toolbars—the Contents (dark) toolbar at the left and 

the Settings (light) toolbar at the right. Use the Contents toolbar to manage and view the map 

contents. Use the Settings toolbar to access options for configuring and interacting with map 

layers. 

4. The Layers pane is also open. As you add data to your map, they will be listed here.  

5. You can expand each toolbar using the Expand icon   at the bottom of each toolbar. 

6. At the top left, click the Add button  on the Contents toolbar.  

7. There are several options for adding data to your webmap. By default, My Content is selected. 

If you have not created content, you can search your organisation. Click My Content and select 

My Organisation. Scroll through the list of layers available.  

8. Click the My Content drop-down 
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9. Use the Add button  to add the layer to your map.  

10. Close the Browse layers panel. 

11. Click the Layers button  the view a list of the layers in the map.  

12. You can rearrange the layers by dragging a layer up or down the list. 

13. In the Contents toolbar, click the Basemap button  to view the basemap options. 

14. Review the legend using the Legend button . 

15. Centre you map in the desired location.  

16. Save the map by clicking the Save button . When you save the map for the first time you 

will need to enter the name, description, and tags. Click Save map when complete. 

 

17. You can rename the layers by clicking the ellipsis button  and selecting Rename. 

18. If you cannot see a layer, clicking the ellipsis button  and selecting Zoom to will pan the 

map to the layer’s extent. 

19. As you click a layer, the Settings toolbar at the right will open showing you the available 

configuration options. 

20. As you hover over a layer you will see the Hide layer button . 

21. You can configure the symbols used on the map in the Symbology section of the Settings 

toolbar. Click Edit layer style when a layer is selected. 

22. You can configure the pop-up using the Pop-up  pane in the Settings toolbar. 

23. Click Title. Notice that the layer title is included. Click the   button at the bottom right 

corner. You can add any attribute field to be the title by selecting it. 

24. Click Fields List  . Here you can configure which fields are visible in the pop-up. 

25. Click the Fields button   in the Settings toolbar. Here you can configure the 

readability of the attribute field names. Edit the names of the fields.  

26. At the top left, click the Home drop-down menu  and select Content. This takes you to 

your Content page which displays all the maps, feature layers and apps you have created.  

 

3.9 Developing Web Applications using the Web App Builder 

ArcGIS Web AppBuilder is an intuitive what-you-see-is-what-you-get (WYSIWYG) application that 

allows you to build web apps without writing code. 

STEPS: 
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1. On the My Content tab of the content page, click Create, choose Web AppBuilder, and 

select 2D or 3D. Alternatively, you can open the item details of a map, click Create Web App 

and choose Web AppBuilder. 

2. Fill in the tags, summary and select the folder where the app will be saved.  

3. Configure the look and feel of the app by choosing a theme. A theme includes a collection of 

panels, styles, layouts, and preconfigured widgets. 

4. Select a map or a scene you've created or choose one from your organization. If you open 

Web AppBuilder with a map or scene already selected, you can change it, if needed. 

5. Widgets give your app functionality, such as the ability to print an overview map. Each theme 

has its own preconfigured set of widgets, and you can add more widgets. 

6. Configure attributes to customize your app banner with a logo, title and hyperlinks. 

7. You can preview your app with popular device screen sizes (2D apps only). When you've 

completed the previous steps, save and launch your new app. You can view and edit your app 

later by accessing it in your Content page. 
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Module 4: Marine Data Hub Administration 

This module will describe core administrative tools and functions necessary for managing the MDH. 

 

4.1 Overview of the MDH GeoPortal Organisation Page 

The Organization page is divided into tabs to help you perform a variety of administrative tasks. The 

Overview tab provides key information about your organization, such as subscription details, credit 

status, total members, and available add-on licenses. 

 

The Members page allow administrators to view members added to the portal. Administrators are 

responsible for inviting members to join or adds members directly. Members can be added 

automatically, or you can send an email invitation for users to accept. You can add multiple members 

automatically by uploading a CSV file of names and email addresses. Administrators can assign and 

unassign add-on licenses, change a member's user type, and reset their password. You can also enable 

accounts for Esri access and delete the member from the organization. 

As an administrator or member with privileges to manage licenses from the Licenses page, you use 

ArcGIS Online to specify which members have access to licensed apps that aren't already included in 

their assigned user type.  

In the Status tab, you can view status reports for the organization. You can access interactive, detailed 

usage reports and see general information. Reports are organized into three categories: content, 

members and groups.  

From the Settings tab you can configure the organization’s profile. This includes options for a name, 

logo, and summary for your organization. This information is displayed for organization members and 

visitors to your website. You can set your organization's default region, language, number and date 

format, and short name. You can also choose the administrator or administrators who will be listed as 

points of contact. 

 

4.2 Creating and Managing Roles 

A role defines the set of privileges assigned to a member. Once assigned, roles can be changed by 

administrators and those with privileges to change member roles. When you assign a role, it must be 

compatible with the member's assigned user type.  

STEPS: 
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1. At the top of the site, click Organization and click the Members tab. 

2. Search for members by name or username. 

3. To change the role of one member, click the Role drop-down arrow and choose a new role. 

4. To change the role of multiple members at once, check the box next to the name of each 

member whose role you want to change, above the list of members, click Manage user types, 

in the window that appears, search for the role you want and select it. Click Save. 

 

4.3 Creating New User Roles 

You can also create a more fine-grained set of privileges by creating custom roles. 

STEPS: 

1. To create a role, at the top of the site, click Organization and click the Settings tab. 

2. Click Member roles on the left side of the page. 

3. Click Create role. In the Create role window, provide a name and description for the role. The 

name must be unique within your organization and can contain up to 128 characters. They are 

not case sensitive. Administrator, Publisher, User, Data Editor, and Viewer cannot be used as 

names for custom roles. The description can have up to 250 characters.  

4. You can change the privilege compatibility setting and review the compatible user types and 

available privileges. Or you can select Set from existing role and import settings from an 

existing role or template on which to base the new custom role. 

5. Select the privileges for the custom role. 

6. Click Save. 

7. Assign the custom role using the steps in the previous section as a guide.  

 

4.4 Automating Administrative Tasks using ArcGIS Notebooks 

ArcGIS Notebooks is built on Jupyter Notebook, which is an open-source web-based IDE (integrated 

development environment). ArcGIS Notebooks is specifically customized to work the ArcGIS 

platform allowing you to take advantage of the benefits of Python while using the ArcGIS 

environment. Using ArcGIS Notebooks allows you to collaborate, automate and document your 

workflows.  

Notebooks can be used in ArcGIS Pro, ArcGIS Online and Portal for ArcGIS. 

STEPS: 

1. Login to IMA’ Portal or ArcGIS Online site. 

2. Click Notebook in the menu at the top of the page. 

3. Click Esri sample notebooks. Here you can find notebooks with instructions on how to 

perform tasks with Notebook. 

4. Open the Administration: Manage and allocate credits notebook. 

5. A notebook is made up of cells. There are three main types of cells: code cells, output cells, 

and markdown cells. The default option is “Code”; Python code is written in these cells. 

Human-readable text cells should use the “Markdown” type. Use these cell types to 

document or explain your code. Output cells should the results of the code executed. 
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N.B. Additional sample notebooks have been provided to you in the Sample Notebooks folder. New 

notebooks are periodically available on Esri’s Github.  

6. You can use code from the sample notebooks or by other users to create customised 

notebooks. 

7. Open the sample notebooks with Jupyter Notebooks on your local machine – Jupyter is 

installed on any computer that has ArcGIS Pro installed. The code can be copied to a notebook 

on ArcGIS Online or Portal for ArcGIS. N.B. ArcGIS Online Notebooks does not have access to 

overwriting local files. You can use the ArcGIS API for Python in Jupyter to access data. 

8. Navigate to folder that be your notebook directory. 

9. Click New and select Python 3 to create a new notebook. 

10. Using this technical article as a guide, a notebook that allows you to backup online feature 

classes locally.  

 

4.5 Backing up and Restoring Geospatial Data 

A backup is a copy of a geodatabase that can be restored if a problem occurs. Geodatabases on 

database servers use SQL Server simple backup and recovery. 

STEPS: 

1. Log in as a server administrator or geodatabase administrator, start ArcMap, and open the 

Catalog window. 

2. Double-click the database server that contains the geodatabase for which you want to create 

a backup. This connects you to the database server. 

3. Right-click the geodatabase for which you want to create a backup file, click Administration, 

and click Backup. 

4. The backup file is created in a default location. Change this, type the path or browse to the 

new location to which you want to save the backup file. Note, you can only browse to a 

different location if you are a server administrator. If you are a geodatabase administrator, 

you must type the path to the location. 

 

5. Click Ok. Note that the Administration tab of the Geodatabase Properties dialog box indicates 

the name of the last backup file and the date when a backup was last performed for the 

geodatabase. 

https://github.com/Esri/arcgis-python-api/releases/tag/v2.0.1
https://support.esri.com/en/technical-article/000022524
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6. Navigate to the backup location, you should see an .bak file. 

7. To restore a geodatabase, right click the database server then click Restore. 

8. Navigate to the backup location and select the appropriate .bak file.  

 

9. Click Ok. Note that you cannot have multiple geodatabases with the same name on a database 

server. 

 

4.6 Troubleshooting and Using ArcGIS Server Manager Log Files 

Monitoring server logs helps you identify errors, troubleshoot problems, and address issues with your 

site. When an event occurs in your site, the event is captured and recorded in the logs. To view 

messages associated with the event, you'll need to query the logs. The URL for ArcGIS Server Manager 

is https://mdh.ima.gov.tt/server/manager. Alternatively, you can open Manager from the operating 

system shortcut that is installed with ArcGIS Server. 

STEPS: 

1. Open Manager and sign in as an administrator. 

2. Click Logs > View Logs to review the current logs. Some messages are returned along with 

additional information. 

3. If you suspect there is an issue with the server, or a user reports a problem, you'll need to 

reproduce the event, capture the event with the logs, and query the logs to obtain information 

about the event. All events record specific information, such as the log level, the time at which 

the event occurred, and the machine on which the event occurred. All of this information can 

help you troubleshoot your server more effectively. By default, only the Level, Time, Message, 

and Source properties display in the log message window. ArcGIS Server can only retain 1,000 

logs at a time. Only the most recent 1,000 logs are retained. 
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Resources: 

https://support.esri.com/en/technical-article/000018326 

https://enterprise.arcgis.com/en/documentation/install/database-server/10.8/intro-workgroup-

database-server-installation.htm 

https://enterprise.arcgis.com/en/server/latest/manage-data/windows/workgroup-

geodatabases.htm 

https://gis.stackexchange.com/questions/400854/back-up-feature-services-with-a-script 

https://gis.stackexchange.com/questions/420300/exporting-fgdb-from-arcgis-enterprise-using-

arcgis-python-api 

https://support.esri.com/en/technical-article/000018909 

https://support.esri.com/en/technical-article/000022524 

https://github.com/highered-esricanada/arcgis-notebooks-

tutorial/blob/master/notebook_basics/arcgispro_notebook.ipynb 

 

 

https://support.esri.com/en/technical-article/000018326
https://enterprise.arcgis.com/en/documentation/install/database-server/10.8/intro-workgroup-database-server-installation.htm
https://enterprise.arcgis.com/en/documentation/install/database-server/10.8/intro-workgroup-database-server-installation.htm
https://enterprise.arcgis.com/en/server/latest/manage-data/windows/workgroup-geodatabases.htm
https://enterprise.arcgis.com/en/server/latest/manage-data/windows/workgroup-geodatabases.htm
https://gis.stackexchange.com/questions/400854/back-up-feature-services-with-a-script
https://gis.stackexchange.com/questions/420300/exporting-fgdb-from-arcgis-enterprise-using-arcgis-python-api
https://gis.stackexchange.com/questions/420300/exporting-fgdb-from-arcgis-enterprise-using-arcgis-python-api
https://support.esri.com/en/technical-article/000018909
https://support.esri.com/en/technical-article/000022524
https://github.com/highered-esricanada/arcgis-notebooks-tutorial/blob/master/notebook_basics/arcgispro_notebook.ipynb
https://github.com/highered-esricanada/arcgis-notebooks-tutorial/blob/master/notebook_basics/arcgispro_notebook.ipynb

